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Welcome to the latest edition of my monthly Final Cut Studio newsletter for December, 2008!
The goal of this newsletter is to provide information helpful to the professional user
of Final Cut Pro. This newsletter publishes each month. Key articles from past
issues are posted on my website each month for your reference. At the end of
each year, all newsletters for that year are bundled and available in my store. All
software references are to Final Cut Studio 2 unless otherwise noted.
Please invite your friends to visit my website -- www.larryjordan.biz. There you'll
find daily tips, latest industry news, over 400 articles and tutorials to help you get
the most out of Final Cut!
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WRAP-UP

WELCOME
Well, 2008 is rapidly winding to a close. At this time of the year, we can either celebrate the
holidays or get depressed about the economy. I've decided to focus on celebration - its more fun.
So, here's the latest edition of my newsletter to give you something to read between rounds of
egg nog, plum pudding, and holiday parties.
Also, one other note -- my team and I are planning what new training to create for the next year. I
would be really grateful if you could take a minute to complete our survey. This would help us a
lot in understanding the kind of training we should work on.
Finally, in case we don't chat between now and the end of the year, a very Merry Christmas,
Happy Chanukah, and Happy New Year to you.
May the end of 2009 be better than the end of 2008!
[ Go to Top. ]

TECHNIQUE: USING NESTS TO CLEAN UP DISSOLVES
BETWEEN CHROMA-KEYS
Steve Gagne sent in a question that sparked this tutorial. He was dissolving between chromakey shots and in the middle of each dissolve, the foreground clip color-shifted to green. He
thought this could be fixed using nests, but needed some help in figuring out how.
Actually, nests are an excellent way to fix this problem and Steve gave me a great reason to talk
about it in this issue.

First, let's define a term: Nesting is the process of putting one sequence into another sequence.
You can do this either by dragging a sequence from the Browser into the Timeline, or by
selecting the clips you want to create a sequence from in the Timeline and applying a menu
choice.
Regardless of how you create it, a nest is always a sequence contained inside another sequence.
DISSOLVING THE OLD-FASHIONED WAY
Let's start by illustrating the problem. Here's a wide shot where Katie is standing up and
stretching in front of a green screen.

Next, we cut to a close up. Both the foreground and background images changed between shots.

If we leave this transition as a cut, everything works great. The two shots will edit together
seamlessly. However, if we dissolve between them, watch what happens.

In the middle of the dissolve, the green background starts to show through Katie - look
specifically at her raised elbow and arm in the upper right corner of the frame. Notice how it has
gone from blue to green. This is caused by the dissolve altering the background, which changes
the results of the key.

As you can see here, I'm dissolving both the foreground and the background clips. However,
even if the dissolve is only in the foreground with the background remaining the same, the results
are identical - the foreground goes green.
NESTS TO THE RESCUE
We can solve this problem by creating a pair of nests - sequences of clips contained in other
sequences - where one pair contains the clips before the dissolve and the second pair contains

the clips after the dissolve.
To create a nest, select the clips you want to group - in this case, the first clip on both V1 and V2
- and choose Sequence > Nest items. (The keyboard shortcut is Option+C).

Create a nest for each set of clips you want to dissolve between. You'll need two nests, one for
the clips before the dissolve and one for the clips after the dissolve.
You only need to create nests for clips you want to dissolve between. You don't need to nest
clips when you are cutting between shots. There is no quality difference between nested and
unnested clips.
Note: Remember that dissolves need extra video before the In and after the Out.
So, be sure to include extra video at your transition point inside the nest.
Here's what it looks like when you have nested both sides of the dissolve. Since each nest is a
sequence, each can have its own tab in the Timeline.

Note: Nests are dynamic. That means that any change you make to the clips

inside the nest are instantly reflected back to the nest itself. To open a nest to
make changes, double-click it. Once a nest is open in the Timeline, you switch
between it and any other sequence the same way as always - by clicking the
sequence tab at the top of the Timeline.
Now, when you dissolve between nests, the video doesn't color shift.

NOTES ON NESTS
●
●
●
●

●

●

Nests are dynamic. When you change something inside a nest, the nest itself changes.
To apply a filter to a nest, simply select the nest as you would a regular ciip.
To open a nest for editing, double-click it.
To load a nest into the Viewer so that you can adjust a filter or motion effect, Option
+double-click the nest.
To deconstruct a nest back into its component clips, drag it from the Browser to the
Timeline and press the Command key once the nest icon has entered the Timeline
window.
You can nest up to eight levels deep - that is, a sequence inside a sequence inside a
sequence... up to eight times.

One last thought. While I don't use nests very often, when I need to treat a group of clips as
though it was a single clip, nests are perfect.
UPDATE - Dec. 17
Tom Hollingsworth had a followup question:
I read your piece on using Nesting to improve green-screens.
Any idea why nesting works better?
Larry replies: Tom, nesting doesn't help with the key, it helps when dissolving between keys. And
the reason is that when you dissolve between nests, you are dissolving between two fullycomposited images - the green background no longer exists. When you dissolve between
individual clips, you are changing the relationship between the foreground and the background
which causes the color shifts to occur.

UPDATE - Jan. 1, 2009
Graham Taylor, a UK-based editor, sent this comment in:
I would add that such so-called ‘dirty dissolves’ can occur on all types of
composites involving keyed images on a higher video layer. It is particularly
common when fading a composite title+background[s] to black. It’s good practice
to nest the last frame and then add a fade to black to the nest. It’s a pity that FCP
doesn’t offer a macro for doing this, however!
Larry replies: Thanks, Graham, for adding this.
[ Go to Top. ]

LARRY'S NEWEST VIDEO TUTORIALS
My video tutorial library is continuing to grow - we now
have at least 12 tutorials, with more on the way.
One of the questions I am frequently asked is whether
these tutorials duplicate my existing training -- especially
my tutorials on Lynda.com. First, it would not be fair to
Lynda to duplicate work I've done for her. So I try hard to
avoid doing so. While there is some duplication between
my newsletters and these tutorials, I try to make these
video tutorials both timely and unique.
Seeing as some of my other tutorials were created a while
ago, my goal with these video tutorials is to provide new or updated information that wasn't
available when my original tutorials were recorded.
Also, each of these is short and focused on a single subject. For coverage of a complete piece of
software, nothing is better than Lynda.com. For timely, updated, or more specific coverage,
check out these tutorials.
There are three I want to call to your attention this month:
●
●
●
●

Sizing Still Images in Photoshop for Final Cut Pro
Fixing Tape Drop-outs and Video Glitches Using Photoshop
Creating Traveling Mattes in Final Cut Pro - coming Jan. 6
In fact, I'll be adding about six new tutorials after the holidays are over.

These tutorials contain all new information. In fact, the sizing stills title finally solves issues I've
had with determining the correct size for multi-layer Photoshop graphics that I've been wrestling
with for years. In it, you'll find a complete table of numbers to size images for NTSC, PAL, and
HD so that everything comes in looking great.
Also, if you've had to fix a bad frame, or bad section of frames, of video that you could not
reshoot, the Fixing Tape Drop-outs title walks you thru the process of cleaning up still frames or
cleaning up video using Photoshop Extended.
Finally, my newest tutorial is Creating Traveling Mattes. This shows you how to create custom
shapes, import and size them properly, create a video-in-video effect and get it to animate. (I'll
also show you my favorite secret tip for playing an unrendered sequence without first rendering

it!)
I try to add a new tutorial or two each week - here's a list of what we have available.
If there's specific subject you can't find anywhere else, let me know and I'll create it for you and
post it here.
[ Go to Top. ]

TRAINING SURVEY
My team and I are planning some new training for the first half of next year and we want to make
sure what we are creating meets your needs.
I'd be really grateful if you could take a few minutes to answer our nine question training survey.
Please take our survey here - and I'll publish summary findings in next month's newsletter.
Your opinions are important to me, please click here to share your thoughts on our training.
Thanks!
[ Go to Top. ]

A BUG IN A NEW VERSION OF COLOR (v1.0.3)
According to reports coming in from Digital Rebellion, the latest version of Color (1.0.3) which
was updated in early December, does not work with XDCAM footage.
I first posted this to the Latest News section of both the Digital Production BuZZ and my website.
Since then, Digital Rebellion has found a workaround.
If you are shooting XDCAM footage and have upgraded to the latest version of Color, please
read this.
UPDATE - Dec. 16
Late evening, Dec. 16, Apple posted an update to Color to version 1.0.4 which reportedly fixes
this bug. I don't know yet whether it does or not. Here's a link to learn more.
[ Go to Top. ]

MY PHILOSOPHY ON UPGRADING
Apple has released OS X 10.5.6. And, before all the emails start, I want to reiterate:

Just because a company has released an upgrade does not mean you should
upgrade to it. The world will not end if you wait a bit before upgrading.
I've written about upgrading before. But this time, I decided to summarize all my
different thoughts into one article. You can read it here.
[ Go to Top. ]

LARRY'S SEMINARS ARE TRAVELING - AGAIN!

Well, I knew the travel bug would hit soon - I'm taking my seminars back on the road. In
February, I'll be visiting Glasgow, Scotland, London, England, and Dublin, Ireland.
As well, I'll be speaking at the Broadcast Video Expo, in London.
If you have ever wanted to attend one of my seminars, but felt that flying over the Atlantic was
just not worth the effort, please consider joining us at one of our up-coming events.
We have two different days planned - one for students and self-taught folks, and the other for
working pros. Plus, we've worked hard to bring our prices down - something we'll be doing for
our next tour in the US - which we hope will make it possible for more people to attend.
DAY ONE - WORKFLOW
The first day seminar focuses on learning Final Cut Pro Workflow Secrets -getting organized for editing and improving basic editing skills.
The seminar runs four hours.
DAY TWO - TECHNIQUES
The second day seminar showcases Final Cut Studio Pro Techniques -- audio
mixing, video clean-up in Adobe Photoshop, and color correction.
The seminar runs eight hours.
Each seminar is presented lecture-style, though you can bring a laptop for taking notes or
following along.
To learn more, including agendas, times, and specific cities, please click here.
I'm grateful to our sponsors - Academy Class and Creative Loop - for making this event

possible.
[ Go to Top. ]

TECHNIQUE: CREATING A DUAL-LAYER DVD
While I've been teaching DVD Studio Pro for a long time, I haven't had the need to create a duallayer DVD until recently.
In doing so, I learned techniques that I've never covered in training before, so I thought I would
share it with you here.
SOME BACKGROUND
First, though, a quick review.
DVDs are measured in storage capacity. A single-sided, single-layered DVD holds 4.3 GB of
data if you burn it, and 4.7 GB of data if you replicate it (take it to a disc manufacturing facility).
A single-sided, dual-layer DVD holds 8.5 GB of data, whether burned or replicated.
While double-sided discs exist, they have generally fallen out of favor as there is no place to put
a label. As well, the costs of manufacturing a DVD have fallen so much that it is more cost
effective to release multiple discs than to use both sides of the same disc.
For those of you old enough to remember, a DVD (or CD) is like a vinyl record. There is only one
track that slowly spirals from edge to edge. With a record, the track starts at the outside and
spirals in. With a DVD, the track starts at the center and spirals out.
With a single layer disc, burning is easy. The laser starts at the center of the disc and lays down
data until it either runs out of data or runs out of disc.
With a dual-layer disc, things get a bit more complicated.
A dual-layer disc has two layers; one stacked on top of the other. First the laser focuses on the
lower layer, then, when it reaches the end, it refocuses on the upper layer.
There are two ways the laser will write multiple layer data to the disc: OTP or PTP. OTP
(Opposite Track Path) means that when the laser reaches the end of the bottom layer it
refocuses, then starts spiraling back to the center. PTP (Parallel Track Path) means that the
laser zips back to the beginning of the DVD, then starts spiraling out from the center.
The advantage to OTP is that the track changeover is very fast, less than half-a-second. The
disadvantage is that the upper track can't be any bigger than the lower track.
The advantage to PTP is that the upper track can be bigger or smaller than the lower track. The
disadvantage is that it takes a long time for the laser to reset back to the middle -- several
seconds.
My recommendation is to use OTP - setting the break point is harder, but the overall
performance of your DVD is much better.

Finally, while DLT tape has been the traditional means of mastering your DVD for delivery to
replication, increasingly DVDs are used as source masters. For a single layer disc, all you need
to do is burn your material to the disc and the replicator will make a copy of it.
However, as you might suspect, dual-layer discs don't make it that easy. Instead, you need to
create a master using DDP (Data Description Protocol). While DVD Studio Pro supports DDP, it
isn't easy to find, nor is it intuitive to select what you need to know to create it properly.
With that as background, let's take a look at the steps to creating a dual-layer DVD that are
different when compared to a single-layer DVD. These fall into three areas:
●
●
●

Creating a break point
Creating the DDP master files
Burning the DDP files onto a DVD

CREATING A BREAK POINT
Before you spend any time worrying about creating a dual layer disc, finish all the rest of your
authoring. Because setting the break point accurately depends upon working from a completed
DVD; by that I mean that you need to build the VIDEO_TS folder first.
For this example, I was working on a two-disk set on horse training, where each disc was a duallayer disc.
To start, choose the Outline tab and select the name of your DVD -- its at the top of the list.

Then, in the Inspector, change the Layer Options to Dual. Make sure the Track Direction
remains at OTP and don't worry about the Break Point pop-up menu quite yet.
Note: Leave the Seamless option UNchecked. Although this is supposed to allow
smoother transitions between the two layers, in real life it causes more problems
than it solves.
According to the DVD Spec, there are two rules that govern where a DVD changes layers:
●
●

first, the lower layer (Layer 0) needs to be as close to 4.1 GB as possible
second, the top layer can not be bigger than the lower layer

These are easy to state, but there is not an easy way to determine this without a lot of trial and
error.

If your DVD has lots of chapter markers, you may be able to leave the Break Point pop-up menu
set to Automatic. But, frankly, I don't think you'll be that lucky.
So here's one manual method:
●
●

Calculate the total number of video minutes in your DVD.
Figure out which track holds the half way point.

This won't actually help, but it will make you feel better. Instead, let's use DVD Studio Pro to help
us figure it out. To do that, we need to burrow deep into the technical side of how files are stored.
1. Click the Outline tab to display the structure of your DVD.

2. Grab the small two-line slider about half-way down on the right side between the Outline
window and the Menu window. Drag the slider to the left to reveal a new column who's header
reads "By VTS."

3. Video is stored in VOB's (Video Object Blocks) which, in turn, are stored in VTS's (Video Title
Sets). Find the VTS that is closest to the middle of the list and twirl it down. The track listed in the
middle VTS is where you need to put your Break Point.
Note 1 : A Break Point is a special track marker that tells the DVD player when to
switch from the bottom layer to the top layer on your DVD. There is only one Break
Point marker per DVD.
Note 2: This method assumes that you have a reasonably full DVD. If you have a
disk that has less information, you'll need to figure out, based on the list of tracks
in the VTS column, which track is likely to fill the disc to the 4.1 GB level. That,
then, becomes the track that holds the layer break point.

4. A break point should be set somewhere in a track where a half-second pause in the audio and
video won't cause a problem for your views. I try to set mine at the end of a paragraph, when the
action is fairly stationery. I'm not always able to use that point, but its always where I start.

5. Put your timeline playhead where you want to set the marker and press the letter M. A
standard green chapter marker appears at or near the position of your playhead.

6. Click the marker to select it, then, in the Inspector, select the Dual-Layer Break Point check
box. The color of the marker changes to purple with a heavy black dot in the center of the
marker. This is now the point where your DVD changes layers.

7. If you select your DVD in the Outline tab and look in the Inspector, the Break Point menu now
indicates the name of the track where your break point marker is set.
Note: So far, this is really easy. The problem is that you won't know if your marker
is set properly - remember those two placement rules I mentioned earlier? - until
you build the DVD. This is why I always recommend getting all the rest of your
DVD authoring done first. Setting a break point is always a process of trial and
error and requires that all tracks and menus be completed first.
CREATING THE DDP MASTER FILES
In order to test whether your break point is set properly, you need to build your master file. In the
process, you'll also build the DDP folders that the replicator needs to create the glass master
disc for manufacturing.
To build the DDP master files:

1. Choose File > Advanced Burn > Build and Format. You will be building four folders at this
point:
●
●
●
●

VIDEO_TS
AUDIO_TS
LAYER_0
LAYER_1

2. In the Source section, indicate where you want the VIDEO_TS and AUDIO_TS folders stored.
I usually create a folder on my second drive, named the same as my DVD. Inside that is where I
store the two _TS folders.
3. Then, since the Destination pop-up menu defaults to burning a DVD, I change the Output
Device to Hard Drive.

4. Here's a potential problem: check with your replicator to determine what DDP format they
want. DiscMakers, for example, wants DDP v2.0 files. This may vary by replicator so be SURE to
check. Be careful not to select IMG or CMP.

5. A dialog will pop-up asking where you want the DDP folders stored. I generally put then in the
same folder as the _TS folders - just so I know where they are - however, you can store them
anywhere.
Note: DDP files are ONLY for mastering, you can not play them on your DVD
player. If you don't replicate your discs, you don't need to create DDP folders.
6. Click Build & Burn to create your files. This will take a while, so don't be impatient.
WHEN THE BUILD FAILS
Notice I didn't say "IF the build fails...."
When the build fails, you'll get one of two error messages. The first states that Layer 0 is too big.
It exceeds the 4.1 GB limit. In which case, you need to go back to your break point marker and
move it closer to the beginning of the track.
The other error message says that Layer 1 can't be bigger than Layer 0. (Remember, since the
laser starts at the end of Layer 0 and spirals back to the beginning at the center of the disc, we
have a limited amount of room here.) In this case, you need to move the marker closer to the end
of the track.
After moving the marker, repeat the process of building your files.
This becomes a time-consuming balancing act to get the layer point exactly where both rules are
met and you have a layer transition that doesn't totally destroy the flow of your movie.
It generally takes me four or five attempts before I get it right. When you get it right, no error
dialogs appear and DVD Studio Pro happily builds all your files.
BURNING THE MASTER FILES ONTO A DVD

When everything is done, you'll have a folder with the name of your DVD, with an AUDIO_TS,
VIDEO_TS, and two Layer folders inside it.
The one thing you DON'T want to do is send your replicator a dual-layer DVD -- it won't work for
a master. They will yell at you. It will be awful.
Also, according to the replicators I've spoken to, while DVD Studio Pro is excellent for creating
DVDs, it is not a good choice for burning the masters. A much better choice is Roxio Toast.
Specifically, the latest version of Toast - v.9.0.4.
That's because the DVD needs to be burned using the UDF file system (um, UDF is not Mac and
not Windows - its Unix.)

So, after your Layer folders are created, open Toast and select DVD-ROM (UDF). Drag the
entire Layer folder into Toast and burn it. Don't rename anything.
Each Layer folder is burned to its own DVD.
Then, you ship the DVDs off to the replicator and sit back and relax - knowing that you've done
everything possible to make your masters as accurate as possible.
Note: There's one more thing you need to pay attention to, and that's the media
you are burning your DVDs onto. Again, based on my own experience and the
experts I've talked to, I recommend three brands: Taiyo-Yuden, Verbatim, and
MAM-A. Never, ever, buy DVDs on price. The cost of the disc is nothing
compared to the cost of losing your data.
For more on this, see my next story on picking the right optical media.
LAST THOUGHTS
The process of creating a dual-layer disc was more complex than I expected. And it took a
number of phone calls and false starts before I got it right.
Remember to finish authoring your DVD before setting your break point. And be patient, don't
expect to get your break point setting right on the first try.
Oh, and one other thing. Talk to your disc replicator BEFORE you start creating the masters to
be sure you are creating something they can work with.
UPDATE - Dec. 21
Uli Plank, a long-time reader and contributor from the Institut für Medienforschung added:
While VOB's are limited to 1 GB in size, VTS's are not directly related to any
specific size. One VTS can hold the whole movie on a DVD in a row of VOB's or
there can be lots of small VTS's. So, it doesn't help very much to choose one in
the middle. To take some of the guesswork out of finding a good layer-break and
avoid multiple tries on time-consuming multiplexing, let DVD SP do some of the

work.
First make a duplicate of your whole project and work on that!
With your VTS list open and keeping an eye on the size of your DVD, start
deleting VTS's from the end (they'll be arranged on the DVD physically in that
order). When the size falls below the size for layer 0, undo the last delete. Now get
into the timeline for that VTS and start pulling back the video from the end while
watching the size again. You don't need to care too much about sound, since it's
size is small in relation to the video.
When it gets below the layer 0 size, take note of that position. Start to look for a
convenient layer- break (LB) point forward from there and set the marker. BTW,
the marker doesn't need to be checked as a chapter marker as in your screenshot,
it can be a LB only. You can set several potential LBs for DVDSP to choose from.
This method works pretty well with projects where video and audio are already
encoded, as I'd typically do it for professional work. In most cases I don't need
more than one try to get a valid LB.
While DLT is still the industry standard for DVD authoring, you can send masters
for the two layers on separate Data-DVDs as you wrote, but I'd suggest to make
duplicates for each layer (clearly marked as backups) if your deadline is close, for
the rare case that even high-quality DVDs can't be read correctly at the replicator's
plant. Plus, check with the replicator if they want DDP or CMF.
Larry replies: Uli, thanks for the additional information. Keep in mind that most DVD recorders
can't create a CMF disc, that generally requires special equipment. Second, your approach
assumes the size indicator is accurate. While I have serious questions about the visual
thermometer in the toolbar, the size of the DVD as indicated numerically in the Inspector I've
found generally accurate.
[ Go to Top. ]

HIGHLIGHTS FROM GV EXPO
This first appeared on my blog, but it is interesting enough to share with you here. (www.
larryordan.biz/blog).
Note: By the way, if you haven't checked out my blog yet, feel free to stop by. I try
to update it several times a week. You can also get it as an RSS feed.
The Government Video Technology Expo was held Dec 3 - 5, 2008, in Washington, DC. I was
there covering the event for the Digital Production BuZZ - my podcast.
During the Expo, we interviewed something like 30 vendors to get a better idea of what we can
expect in our industry next year.
You can see a list of all our interviews and shows here.
However, there were a few highlights that I want to share with you. First, because they didn't
make our main show due to the press of deadlines. Second, because they discuss issues we
work with every day. And, third, because it's nice to add audio to my newsletter.

PICKING THE RIGHT OPTICAL MEDIA
Kevin Towey, Regional Sales Manager for Microboards Technology. His company
manufactures equipment for duplicating CDs, DVDs, Blu-ray Discs, even, to my surprise, USB
drives. Anyway, during our conversation, we started talking about how to choose the best optical
media for burning discs. I’ve been talking about this issue for a while, but Brian did such a nice
job summarizing this, that I wanted to share it with you here.
If you need to make sure the discs you burn will play, you need to listen to this short interview.
Note: Once the clip loads into your browser, you may need to press the RETURN
key to start playback.
Click here to play Brian's audio. (TRT: 1:29 768 KB)
THOUGHTS ON THE LIFE-SPAN OF MAGNETIC TAPE
As long-time readers know, I've been looking for ways we can safely store tapeless media for
long periods of time.
Spectra Logic makes equipment for archiving servers and media. More specifically, they make
LTO tape drives, which are my current favorite for backing up tapeless media.
Hossein ZiaShakiri, vice president of business development and alliances for Spectra Logic,
chatted with me on my podcast - Digital Production BuZZ - about the best way to back up media,
the software necessary to do so, and what kind of equipment to consider. However, toward the
end of the interview, our discussion shifted to the life-span of magnetic tape.
Again, this is a short quote, but I think you’ll find it interesting, since it comes from an individual
with a lot of experience in making sure the data you put on the tape is able to be successfully
played back.
Click here to play Hosssein's audio. (TRT: 0:30 600 KB)
[ Go to Top. ]

PLUGGING THE BUZZ
If you haven't listened to the Digital Production BuZZ yet, click here to see what we have
coming up this week.
We cover the full spectrum of digital production, post-production, and distribution. From first
concept to making money. We air a new show every week - Thursdays at 6:00 PM Pacific time.
Shows are archived and found on iTunes and our website.
Click here for a listing of what's on this week's show.
Click here to visit our archives.
Click here to read the latest industry news.

I'm very proud of this show - the quality of our guests and the depth of our interviews make it
unique in the industry.
Take a listen and let me know what you think. As always, I enjoy hearing from you.
[ Go to Top. ]

THOUGHTS FROM TRAINERS ON TRAINING
I had an idea a few weeks ago that I want to share with you.
I've had the pleasure of listening to or training with some truly outstanding software trainers. (I've
also listened to some pretty lame ones, too, but we'll ignore them for the moment.)
The problem is that since trainers work alone, its hard to improve your skills.
So, I decided to start a series of interviews with outstanding trainers to learn what they do and
what others can learn from them.
The first three interviews are complete and if you are interested in training, or improving your
training skills, you'll want to listen to these.
Matthew Geller is a lead trainer for Apple, specializing in Final Cut Server and
XSAN. He started is career as an actor, but in spite of that, no one does tech
better than Matt.
Mary Plummer is another lead trainer for Apple, specializing in Final Cut Studio
and Soundtrack Pro. She runs her own training company in Florida.
Steve Martin has probably trained more Final Cut trainers for Apple than just
about anyone else on the planet. Steve was the person who suggested to me that
I get certified to be a Final Cut trainer -- a piece of advice for which I am totally
grateful.
Each interview runs about fifteen minutes.
Click here to view a list of our "Trainers on Training" interviews.
I hope you enjoy them - I had fun putting them together.
[ Go to Top. ]

NOTE: QUICKCLUSTERS ARE NOT YOUR FRIENDS
Compressor 3 supports two types of computer clusters to speed video compression: cluster of
multiple CPUS inside one computer and clusters of multiple computers.
My advice is to avoid multiple computer clusters unless you have a VERY fast network and all
your media is on shared storage.

I've been reading articles recently which detail the woes people are having trying to set up
QuickClusters between multiple computers. Frankly, the speed just isn't there.
A much better choice is to create a cluster using all the CPUs in your computer. Here's an article
I wrote recently that shows you what you need to know about speeding up compression on your
own system.
UPDATE - Dec. 17
Lorin David Schultz, though, was confused:
When you wrote: "You use System Preference to create a Virtual Cluster and set
the number of instances to 50% of your processors..."
Why 50%? Why not 100%, or at least 7 of the available 8?
Larry replies: Lorin, good question. If you are only using your system for video compression, you
can assign as many processors as you want. The more you assign, the faster it will compress.
However, if you are using your computer for other tasks, assigning more than 50% of your
processors will significantly slow down all the other work you are doing on your system.
[ Go to Top. ]

LARRY HAS A NEW BOOK!
My third book has just been released by Peachpit Press
entitled: Edit Well - Final Cut Studio Techniques from
the Pros.
What we did is take the best from over two years of Edit
Well newsletter articles and recompile them in a book.
Every article in the book can make a significant difference
in your understanding of how to make the most of Final Cut
Studio.
Peachpit describes it this way: Edit Well: Final Cut Studio
Techniques for the Pros is the book that in-the-trenches
editors have been waiting for. It offers a holistic approach
to using the tools in Final Cut Studio for those who are
responsible for a variety of tasks just beyond straight
editing.
Written by the preeminent experts and practicing
professionals in their fields, contributors include over 15
authors such as Larry Jordan, Kevin Monahan, Mary Plummer, Mark Spencer, Tom Wolsky,
and Alexis Van Hurkman. Each chapter features insight on a particular tool in the Studio,
whether it be Final Cut Pro, Soundtrack Pro, Motion, or Color. In addition, video tutorials and
audio interviews of top Final Cut Pro editors around the world are available for free on the
companion website.
You can save 35% if you buy it directly from Peachpit Press and enter this discount code:
EDITWELLBOOK. Here’s the link.

It is beautifully illustrated in full color with hundreds of screen shots. 336 pages.
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READER MAIL
IMPROVING EXPORT QUALITY
Paolo Raho sent in a question I've been getting a lot recently:
I'm very familiar with all of your tutorials, and I know for the highest quality it is
always recommended to export the sequence under the settings in which the
footage was shot and captured. I was reading a couple of forums lately and they
were discussing the idea of exporting a DV sequence as 8 or 10 bit
uncompressed; a process that would yield a higher quality image, specifically for
text and graphics. I wanted to get your opinion on this, whether there was any
truth to it.
And one other question along the same lines, let's say I have shot and captured in
DVCPRO HD, and exported a sequence under the same settings, has my
exported movie suffered any quality loss, or has it remained identical to the
captured footage? That is to say, does exporting, even under the correct settings,
result in an quality loss?
Larry replies:Paolo, Damon Jamal echoes your questions with his own:
Can you explain:
1) why when exporting using animation or prores the resulting quicktime movie
looks better and
2) why that doesn't matter?
Also you wrote to export as quicktime using current settings but if your sequence
is set to prores (for example) then wouldn't that result in what I wrote above in #1?
I'm just a little confused, so I would appreciate it if you can shed some light on
this...
Larry continues: Here's the basic problem. As Martin Baker describes in the Update below, on
many systems DV is SAVED at high-quality, but not DISPLAYED at high-quality.

Here is an example. The image on the top is a portion of an exported DV clip displayed in
QuickTime, the image on the bottom is the same portion using the Animation codec. Clearly, at
this level, the Animation codec is FAR superior.

But, let's run both of these through Compressor and check the compressed images. Now, the
two variations look very, very similar. (Both of these sets of images were further compressed into
JPEG from Photoshop using the Maximum quality setting. - so some additional quality loss has
occured.)
Again, the difference is that DV requires a hardware chip for high-quality display in real-time.
Compressor contains all the necessary algorithms to properly compress the image, but it can't do
so in real-time. For this reason, be sure to make your quality decisions after a file goes thru

compression, and not before.
So, to answer your questions more specifically:
1. Is it better to export as 8 or 10 bit uncompressed? My feeling is that if you are
shooting DV, no. If you are working with 8-bit or 10-bit source material - yes. The
problem is that DV does not display at high quality on a Mac monitor. For this
reason, people assume that the video is poor quality. This is a display issue, not a
video quality issue.
I've done a test where I export DV footage using the Animation codec - the highest
quality SD codec on the Mac - and the DV codec. I compressed both and
compared them. To the eye, the compressed versions were identical. The
intermediate versions looked significantly different - DV looked far poorer than the
Animation codec. But after compression they looked the same.
2. Does DVCPRO HD change? Well, that depends. If you are adding effects,
transitions, or something requiring rendering, then, yes, the video is being altered
from its original state. On the other hand, that's why you applied the filter in the
first place. As to whether that's a quality "loss" that depends on the filter you
added - I would suggest that a color correction filter, properly applied, will make
the clip look better.
If you are simply putting the video to the timeline and not adding effects what you get out is the
same as what went in.
UPDATE - Dec. 18
Martin Baker, from Digital Heaven, wanted to clarify this a bit more, so he wrote:
It's not a lack of hardware that causes the softness, it's historical reasons. When
DV was the new kid on the block and Macs were way less powerful than they are
today, QuickTime Player decoded DV at half res to reduce the amount of
processing required. Apple did this by adding a "High Quality" playback flag to the
DV video track and disabling it by default when exporting a movie from FCP.
●
●

High Quality disabled = half res
High Quality enabled = full res

Most people freaked out when they saw their videos looking soft but weren't aware
this is purely a playback issue inside QuickTime Player and isn't connected with
the quality of the export. The DV file is full res, which explains why recompressing
it to another format gives the same results as Animation codec.

The old "fix" was to enable the flag manually by opening Window > Movie
Properties, or typing Command+J,selecting the Video Track, and checking the
"High Quality" checkbox inside Visual Settings tab.
When Apple released QuickTime Player 7, they added a preference (QuickTime
Player > Preferences > General > "Use high-quality video setting when
available"). If this is enabled, then QuickTime Player will override the flag in the
movie and always play DV movies at full res.
Larry continues: Thanks, Martin, for the update. The only point I want to add is that in most
systems I see, this High-Quality default is turned off -- which probably adds to the confusion. And
thinking of preferences, Ben Balser wrote in with another that we need to pay attention to.
UPDATE - Dec. 20
Ben Balser, from the South Louisiana Final Cut Pro User Groups, added this:
To add to the discussion about QT Player's video quality settings for playing back
video, there's also this preference folks should look for. I've found many of my
User Group members complain about color shifts between the QT version and the
FCP versions. Here's how to fix it. By the way, I'm running QT Pro 7.5.5.

In QuickTime Player go to the "QuickTime Player" menu, to Preferences, in the
General settings, at the very bottom of this window, make sure the last setting,
"Enable Final Cut Studio color compatibility" is also checked off, as QT Player
uses a different gama than FCP does.
Larry replies: Thanks, Ben and Martin, for these updates.
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THE DREADED ERROR 34
Simon Miller, of Plainview, NY, writes:
OK. I give up. What's causing Error 34 whenever I round-trip to Soundtrack Pro?

What do I do to get rid of it?
Larry replies: Simon, Error 34 is scary, but not life-threatening.
According to Apple's Support website, Error 34 occurs when your hard disk is full. This can be
caused by the disk being too full, or the settings in Final Cut Pro > System Settings for
Minimum Free Space are set higher than the total free space on your hard disk.
In short, you either need to remove files from your hard disk, or reduce the minimum free space
requirement in System Settings.
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WHEN IS ANALOG REALLY DIGITAL?
Ashish Guliani, from Delhi, India, writes:
Sir, I have a question popping in my mind for last couple of years and i couldn't
find an answer.
My question is .. since we all know what an Analog video and Digital video is and
what are the differences between the two, DigiBeta, DV Cam / DVC Pro are very
much digital formats but they record just like analog format, i mean when we shoot
with DigiBeta or DV Camera its the tape which is recorded through the magnetic
head of the camera just like in analog even the player and recorder, its the same
process.
Normally digital camera's these days captures straight on hard drive but how Digi
Beta and DV cam's are called Digital when they have same old magnet tape ?
Larry replies: Ashish, this is a great question!
And the answer is that recording to tape does not make a video signal analog. For instance, your
hard disk records information magnetically, yet no one would suggest your hard disk is an analog
device.
Similarly, computer servers around the world are backed up every night to magnetic tape, yet,
again, no one would say that we are converting the data stored on our servers to video.
No.
It is not the magnetic recording that makes a signal analog or digital. It is the information IN the
signal that makes the difference. With DigiBeta, DV, DVCPRO, and other digital formats, the
data being recorded onto the tape is a series of ones and zeros. Digital DATA in a magnetic
signal.
With VHS, Hi-8, Beta SP, we are recording a series of signal fluctuations, similar to a quicklychanging audio waveform, rather than digital ones and zeros. Because this analog signal is not
as precise as digital, the signal has more noise or error in it.
Hope this helps.
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COMPRESSING FOR YOUTUBE
Sam Shirakawa writes:
I have exported a project from FC to compressor, which in FCP is formatted
Broadcast 720 x 480. I am trying to send it to YouTube, but the image looks
squished. When I have sent the same project to YouTube using Quicktime, the
letterbox image ratio in YT is the same as it is in FC, but the quality is awful. I want
to use Compressor because I want a larger file to send to the YT server, but this is
giving me major agita. I would appreciate it much if you could tell me how to fix
this or direct me to a tutorial.
Larry replies: Sam, thanks for writing.
Brian Gary has formed an entire cottage industry around explaining how to compress for
YouTube.
Ken Stone has published a series of tutorials that you will find very helpful, as Brian does a great
job of explaining the process.
Here are the links to take you where you need to go.
Part 1: YouTube Encoding - Locked and Reloaded
http://www.kenstone.net/fcp_homepage/you_tube_redux_gary.html
Part 2: Encoding for YouTube Part 3... HD Strikes Back
http://www.kenstone.net/fcp_homepage/you_tube_hd_gary.html
Thanks to Brian and Ken for making these available.
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CREATING 14:9 TITLE SAFE IN A 16:9 IMAGE
David Smith, from Glasgow, Scotland, writes:
I've had a question from a delegate who is asked at times for 16:9 with a 14:9 Title
Safe. I cant think of a way of doing it other than bringing in a layer with a 14:9 Title
Safe illustrated from Photoshop or similar and adjusting it's opacity in some way?
Any suggestions?? Can you adjust the Title Safe in Final Cut or is it defaulted to
the sequence settings?
Chris Roberts, from somewhere near Birmingham, England, responded:
Your answer is here - http://www.digital-heaven.co.uk/fcplugins/dh_widesafe.php courtesy of Martin Baker and Digital Heaven!
Larry adds: If you haven't checked out Martin's website, you owe it to yourself to do so. He has
some wonderful toys: www.digital-heaven.co.uk.

UPDATE - Dec. 17
Elliott Mitchell had a question:
Title safe and action safe areas are a consequence of over-scanning in an analog
TV receiver. I might be wrong, but I wouldn't think that there's any overscan in
digital imagery presented on digital, flat screen screens. So as we move to our all
digital future, will those safe areas just be artifacts of the past?
Larry replies: If all you use are LCD or LED displays, you are correct. However, there is a lot of
rear-projection HD, as well as front projection HD, which still has to deal with overscan. For this
reason, its too early to start taking text all the way to the edge.
Title and Action Safe will be a fact of life for a significant while longer.
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HEY, BUDDY! KNOW A GOOD SUBTITLER?
Simon Morice writes:
The prospect of typing in ten zillion accurately spelled and ordered words for
subtitles fills me with dread but I can ameliorate it somewhat by using Dragon
Dictate for the English version at least. And I have tame Russian, French, German
and Portuguese native speakers who are happy to translate for me. But how to
handle all those translations and what document format is best? Is there a
software solution? Where to start?
Larry replies: Ah - the answer is knowing where to look. Bruce Nazarian sent me the answer:
VideoToolShed SubBits Subtitler.
Very cool.
UPDATE - Dec. 17
Andreas Kiel, from Spherico, sent me the following:
Here some notes about subtitling. The big question here is what is a "good
subtitler" - a company, a software, a plugin?
[VideoToolShed's] SubBits is a great - maybe the best - tool to setup subtitles for
one language - to setup subtitles for several mixed languages is another theme
and mostly a tedious work - subtitles are tedious work anyway.
It is quite difficult to handle for example a "multi-language" movie where let's say
three languages are spoken. For subtitles for language 1 you only need language
2 and 3 as subtitles. This will be similar (with other numbers) for the other
languages. For language 4 you need all of them.
So these titles have to have to be organized somehow. A good way of doing that
is do build a FileMaker Pro data base or something similar in Excel. But this only is
organizing them.

What to do with the translators? They need a movie with sound or a sound only
file and hopefully a transcript with timecode or a dialog list to do the translation. To
interchange with many languages a "tab text" format might be the best idea - so
you can add a translation to your data base where it is needed and do have the
language you need in a column and hopefully the timecode for it as well.
All of this can be done more or less easily for the final cut of a movie but will put
you into some kind of time pressure - especially if it turns out that the final cut is
not the final cut.
So in my opinion subtitling starts at the beginning of the production. Final Cut Pro
does allow you to do this as you can set markers on a clip where a subtitle should
appear - just give the marker a unique language name. This way the "virtual
subtitles" will travel with your edit. To set up this kind of workflow it needs a bit of
additional work.
Anyway it's definitively worth to mention my TitleExchange which does allow to
juggle with many of these subtitles formats to get them in and out of the Final Cut
Studio applications for several kinds of use.
The app doesn't allow to set up title timing or render titles like SubBits or the
BelleNuit app does - it's just XML and text based. This approach allows to set up
the titles in many apps and platforms - you can for example use the free version of
BelleNuit to create the timing, then save the file file and "map" it to the text
generator of your choice in Final Cut Pro. There you can do whatever kind of
changes to the titles - export them them as XML and convert them for example to
"Digital Cinema Projection" which will allow independent producers to have
"language packages" for digital cinemas without the cost of "burned in" subtitles.
You can transfer those titles to DVD SP as well and back from there. Lot of
options.
As a note: One of the big players just bought some licenses of TitleExchange, and
bought some Apple FCP stations to run TitleExchange - they only do subtitles with
these Macs. Their film work is done on Avid and other apps on PC.
Larry replies: Thanks, Andreas, for the detailed reply. I'm happy to share your comments.
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IS THERE SUCH A THING AS TOO MUCH RAM?
Steve Mittelberg writes:
Getting back to some basics on configuring a G5, would increasing the RAM
enable faster rendering of multiple streams of video with effects? Does the RAM
need to be replaced in matched pairs? Would updating the graphics card enable
faster rendering times? Would a RAID system be essentially useful only for
backing up or would it also increase performance time when rendering. The Drobo
seems like an excellent solution for a quick and easy backup solution. You didn't
seem to think it would increase speed in editing. Thanks for your feedback.
Larry replies: Wow! What a lot of questions....
Let's tackle these one at a time:

1. Does more RAM speed rendering? The sweet spot for RAM for Final Cut Pro is
about 2 GB. Assuming you have that much, adding much more won't make
rendering go any faster.
2. Does RAM need to be replaced in matched pairs? Yes for towers, no for laptops.
3. Would updating the graphics card speed rendering? No. Though Apple is
hinting that will change in the future.
4. Would a RAID help in backing up or performance? RAIDs are designed for fast
storage and performance. They have no impact on rendering.
5. Is Drobo a good choice for backups? Yes.
5a. Will it increase editing speed or rendering? No.
5b. So, then, what WILL speed up rendering? A computer with a faster CPU.
5c. How about....? Nope, just a faster CPU.
UPDATE - Dec. 17
But, Willard Jensen then added another question:
You make it sound that 2 gig is optimum for FCP. But when running FCP
alongside with Motion, for master templates, and even FCSvr. Don't you need
mote that that? And is it true that one should double Ram so either 1,2,4,8 or 16
and that anything in between could be counterproductive?
Larry replies: Well, if you insist, I'll modify my comments to this:
Changing RAM size does not affect render speed. FCP does not address more
than 4 GB of RAM. However, having more than 4 GB of RAM will help when you
are running multiple applications at the same time as that will minimize the amount
of material that needs to be paged to and from your hard disk.
I don't think there's any significant performance benefits to increasing your RAM in multiples of 2,
thus, "doubling" RAM.
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AUDIO IN DVD STUDIO PRO
Jennie Reinish, from Tidepool Pictures, writes:
Just read your most recent newsletter, and its so valuable, as always! I have
definitely been a victim of this economy, seeing clients dropping so fast I am
stunned.
Anyhow, here is my question, and this has been bugging me for a long time, I
should have asked you a year ago! When I create a DVD in DVD Studio Pro, I
have already adjusted all the audio Final Cut on the video files. If I add audio to

the menu on the DVD, it is always louder than the audio on the video tracks. I
have tried everything I could think of to adjust the volume, but it hasn't worked.
So... how can I adjust the volume on the song/audio file that's on the DVD
menu???
Hope you have an answer!
Larry replies: There is no way to adjust the audio of a clip in DVD Studio Pro. If the levels need
adjusting, you'll need to load the clip into Soundtrack Pro, Final Cut Studio, or ProTools, adjust
the audio level there, then re-export it.
Thanks for the kind words about my newsletters - I'm glad you find them helpful. And I'm keeping
my fingers crossed for ALL of us that we come out of this economic downturn successfully!
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LEE'S QUICK TIP #1
Lee Berger sends in the following tip:
Yesterday a friend of mine told me a tale of woe. 1,000 DVDs duplicated and the
client discovers a few seconds of "Media Offline". Of course watching the program
carefully is the best way to check for errors, but sometimes if you blink or look
away for a moment you can miss something. This is especially true if the program
is long and you are tired of looking at it. I recommended using the Reconnect
Media function.
Right or CMD click the Sequence in the bin and choose Reconnect Media.
In the Reconnect Files window you should see any missing files or renders.

Larry replies: Lee, this is a great tip. Select all the clips in your sequence and choose File >
Reconnect Media. If there are no clips offline, the Offline button will be gray.
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LEE'S QUICK TIP #2
Lee Berger, who obviously has WAY too much free time, then sent in a second tip:
I noticed that one of your recent tips suggests the normalize filter as an alternative
to stacking audio tracks to fix low audio. Another approach is to use the
AUDynamicsProcessor filter which has a Master Gain slider. This filter allows a
great deal of gain adjustment on the fly. Also some audio may benefit from
judicious application of compression.

Larry replies: Thanks, Lee!
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CHANGING LOCKED FILE NAMES
Steve Griepp writes:
Hi Larry, when I went into the finder to change the name of a file it wouldn't let me.
I couldn't add any letters or take any away. What is the problem?
Larry replies: Generally, this is because the file is locked, preventing changes -- or it is open
somewhere.
Make sure the file isn't open in an application, then, select the file.
Type Command+I and the Get Info dialog appears.

Make sure the Locked checkbox is not checked, then enter your new name in the Name &
Extension text box a little lower in the window.
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USING MULTICLIPS IN COLOR
Karl Arndt sent in the following:

Larry, just an update regarding the Multi-cam/multi-clip/Color problem: As of now,
multi-clip sequences are not supported in Color. Hoping Apple will address this as
the relationship between Multi-cam and Color would be huge. I'm depressed this
morning with all the additional work that will be necessary to complete this project.
Larry replies: Thanks, Karl, for this update.
UPDATE - Dec. 17
Shane Ross read this and sent the following:
Why would anyone want to have multiclips in Color? The whole point of color
correction on that level is that you are done. Picture is locked and you are color
correcting now. You no longer need to have the other angles at your disposal. If
you still do then you don't have picture lock and you are not ready for color
correction.
Are they wanting to do some sort of preliminary color correction before they cut?
Then use the 3-way. I understand that the settings you have on the 3-way (one
layer of 3-way only) carries over to Color.
Either way...the guy has to think of color as a final step in the process, not one at
the beginning. Collapse the multiclips, then send to Color.
Larry replies: Shane, thanks. This seems like a much better way to work.
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FREE STUFF
Jon Thorn, at AJA Systems, followed up on a recent article talking about ways to calculate the
speed of your hard disks.
AJA provides a great free utility called the AJA Data Rate Calculator that you can
use to determine how much drive capacity is required for working with a selected
format and a given amount of footage. The application also shows you the data
rate for a given format. To determine if a drive solution has sufficient performance
to support a format, AJA also offers the AJA System Test for benchmarking
storage.
Both the AJA Data Rate Calculator and the AJA System Test are freeware and
can be downloaded form our website. In fact many of the storage manufacturers
use our benchmarking application in their testing and even their advertising!
Larry replies: Thanks, Jon. The AJA website is: www.aja.com.
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MORE COOL ARTICLES

I'm behind in sharing this with you, but Allan Tépper from the Pro Video Coalition, sent me the
following:
Here are two new video articles I just published which may be of your interest or
for your readers:
When to edit native, When hybrid, When pure i-frame, and Why.
Prior to FCP 6.0, in order to have real time editing we had to convert all footage to
the target format (codec, frame rate, resolution, etc.) before editing… or edit
natively. Now editors need to decide, on a case-by-case basis, whether to edit
native, hybrid, or pure i-frame.
Read the article here.
When 25p beats 24p
There are many times when it makes more sense to shoot and edit video at 25p
than at 24p, regardless of the final frame rate(s) to be delivered to various
distribution formats, even if you live in an NTSC (or ex-NTSC) country.
Read the article here.
UPDATE - Dec. 21
Andreas Kiel, from Spherico, points out a potential problem with this approach, however:
I read this article "When 25p beats 24p…" and I somehow totally agree as I've
done several movies using this method.
But there is one big thing which can make this whole method useless - artificial
light. This is (after all the cams and formats become more international) the "old
thing we can rely on". PAL countries do have 50Hz NTSC will have 60Hz.
With my scientific work I have to use a NTSC 30P FPS setup since the projection
systems rum at that speed, but is a nightmare to correct all the traffic lights which
run at 50 Hz AC here as they are switching on and off in the recorded video. Same
could happen with 25P in NTSC lands.
Larry replies: Thanks, Andreas.
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COMPOSITING CONUNDRUM
Dick Osso sent me the following:
I have an image that is basically a commercial product that has a decorative
frame. I want to load it into FCP and add an image or clip inside the frame.
This image loads into Photoshop and shows the transparency inside the drop in
frame area.

When I load this into Final Cut Pro, it does not load with it the transparency within
the image!
What happened?
Larry replies: Here, Ken Stone came to the rescue. Here's Dick, again, with an update.
Ken took my files and discovered that the fix was to change the Alpha Type to
‘Straight’ and not use COMPOSITE ALPHA. It then worked. I thought I'd pass on
the fix to you in case you were going to try from your busy day.
Larry adds: Thanks for the update. The alpha key is controlled from an unusual place: Modify >
Alpha Type. If you ever have problems with a key, especially one created in either Photoshop or
After Effects, changing one of these settings will often solve the problem.
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BLACK SIDEBARS
Denny Goodrich, from Iowa State University, writes:
We are shooting DV and in FCP I am using a DV timeline. The Media 100 would
be 720x486. We noticed that whenever we encoded something for web there
would always be little black bars on each side. After getting clued in to this, I
notice that there are, indeed, very narrow black bars left and right. Why should this
be? The material I get from the Media 100 are QuickTime movies that have been
cropped to 720x480, but these black bars appear here, too. Our current work
around is to blow everything up to 102-percent, but I really don't like to do this.
Larry replies: Denny, please, for the love of humanity, DON'T enlarge your video image past
100%. That's just wrong!
Those black bars called, I believe, horizontal blanking, are a part of every DV frame. It is
designed to allow the electron beam in a CRT to switch from one side of the picture tube to the
other.
If you want to get rid of them, crop your image 2-3% during compression. Or leave them alone.
You'll never see them on a TV set and most people won't notice on video posted to the web.
But get rid of them during compression, not by enlarging your image during editing.
UPDATE - Dec. 21
Uli Plank adds:
While enlarging vertically would be wrong (and very bad in case of interlaced
video), enlarging horizontally only is correct for square pixel displays.
You are right about blanking, and digital video is meant to be 702 pixels wide (plus
9 pixels of blanking on both sides). This size will contain the full 4 by 3 or 16 by 9
image! TVs take this into consideration.

So, if you crop, your image will be ever so slightly squeezed from the sides on
square pixel displays. Adobe has changed it's attitude towards this issue recently
(check out AE in CS4), while Apple still insists on digital video being 720 pixels
wide…
Larry replies: Thanks, Uli. Except, if the cropping is done during compression and you take the
revised dimensions into account for your final image size, the web will display it properly. Clearly,
you would never crop if your goal was to put the material on a DVD or broadcast.
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A REQUEST FOR APPLE
Bob Cusumano, from Boston, writes:
I was working in FCP and was using a master template from Motion. I chose 'open
copy in editor' to work on the fonts in Motion. Could you write your friends at Apple
and ask them if they might include a 'replace this font throughout template'. this
way we don't have to go in and change each title if there are, three, for example.
UPDATE - Dec. 21
Andreas Kiel, from Spherico, has a different opinion, however:
I'm not Apple and I don't think Apple needs to change anything in this case.
If you use the master templates from Motion in the generators [menu] you should
open a copy in Motion if you want to change one clip. If you want to change all
[iterations of this template] open the master file - [this] could be dangerous if you
used the master with other projects.
I made a simple tutorial some time ago how to use Motion templates for subtitles:
http://www.spherico.com/filmtools/TitleExchange/MotionTutorial/index.html
Larry replies: Thanks, Andreas. I agree with your thoughts that changing the Motion template in
Motion would allow Bob's font substitution to occur.
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FIXING PROBLEMS WITH A JVC PROHD CAMERA
Mark was having a problem with a JVC ProHD camera continuously disconnecting from his
system.
He wrote in saying "The Belkin External AC Firewire Hub solved the disconnect
with the JVC-PROHD Camera on the MAC Tower."
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PROBLEMS WITH FREQUENT CRASHING
Frank Jonen sent in the following:
I just traced this bug an hour ago and could verify it via a few twitter followers.
If a Final Cut system or Photoshop (or both) is crashing often or becoming very
slow at seemingly random times check if a process called Nalpeiron is running.
While it behaves like a trojan horse virus in the amount of outgoing traffic and
random system blocks (8 cores at 90% for 30 minutes) it is just a vile copy
protection scheme.
So far I haven't found the files yet on my system since they're hidden with what
seems to be a root kit. When I find a way to safely remove Nalpeiron I'll post it.
The applications that are known to infect systems with it are:
- Tiffen DFX series for Photoshop and Standalone
- Tiffen DFX for Final Cut
The only workaround I have so far is right after the system starts to go into Activity
Monitor and force quit the Nalpeiron process. But then if you need one of the
Tiffen apps you'd need to reboot. Not favorable.
Larry replies: Thanks for letting us know. If this problem has been fixed, please tell me so I can
update this article.
[ Go to Top. ]

A GLIMPSE OF THE FUTURE
Simon Morice, from London, sent me this:
I came across something I think may find its way into the TV landscape one way
or another. Millicent is a sort of DTP system for broadcasting TV which can output
to HD/SDI as well as web. Apparently it's been trialled at the BBC and Channel 4.
Being something of an enthusiastic puppy I had a chat with Mark Rock, the big
banana behind it. It's early days but if it goes wide and cheap then scheduling
disparate material from around the Internet may become a new form of
broadcasting to reach the potato on his couch. A new way to add value for those
disinclined to search out their own material yet who have a computer, a DivX
Connected Set top box or Apple TV etc...
Larry replies: Thanks, Simon. Very interesting.
[ Go to Top. ]

REQUEST FOR HELP

Claes Jonasson asks:
For years when recording live training sessions to video, I have used a multicamera approach to capture everything as it happens. A Canopus TwinPact100
connected between the presentation computer and projector tapped the graphics
signal coming from the computer and converted it to DV, ready to record. All
worked beautifully.
Now all the cameras are HD (720p or 1080p/i). What I haven't found yet is a good
replacement solution for the TwinPact that will take the graphics signal from the
computer and turn it into a recordable HD video signal (preferably 1080). Do you
know of a box that can help me?
Larry replies: Nope. Not a clue. I'm hoping a reader has some ideas...?< (Seconds later, a reader
sent in an answer.) /p>
UPDATE - Dec. 17
So, Mark Triplett, from Sagemont Church, has a suggestion:
You might want to check out the Matrox MXO.
We’ve used them on 2 iMacs for a year or so now in both SD & HD SDI modes
with great success.
Larry replies: This is a great idea. I worked with one last year and was very impressed.
[ Go to Top. ]

A SADDER, BUT WISER, EDITOR
David Scott sends in this sad moral lesson:
Flush with pride at having set up the "perfect" workflow for my Canine Assistants
shows (build it in high def for projection, output sd to DVD for distribution), I
apparently got full of myself. Since the FCP high def build no longer permitted me
to monitor the 16:9 720p image on my trusty Sony monitor, I had a Matrox MXO
overnighted to me (got it this morning). After hours of trying to get it to work, I gave
up and tried to go back to square one and live without external monitoring. Now
playback on the FCP timeline stops cold when it hits the first clip. In fact, all I have
on there now is a slug (plays fine through that) and two FCP-generated, simple
text clips of 5 seconds each. As soon as the playback bar hits the first clip,
playback halts and I get the standard "dropped frame" error message (never had it
before) and none of those suggestions helps.
Moral: Never, never, NEVER introduce ANYTHING new to the workflow when on
deadline (mine is tomorrow night at 7). Ordinarily, wouldn't consider violating this
cardinal rule of video editing but I wrongly assumed the substitution of one
external display for another would be no biggie. How absolutely wrong I was.
Now I face an all-nighter and that's assuming I can get my workflow settings back
to where they were. I am sadder and not any wiser.

Larry replies: David, I'm VERY sorry for YOUR problems. Even updates for the most innocent of
reasons can backfire when deadlines loom. I'm using your predicament as an object lesson for
the more exuberant among us.
For those that need the reminder, please read my thoughts on upgrading here.
Thanks for writing!
[ Go to Top. ]

THE INS AND OUTS OF INS AND OUTS
Stephen Larcovic writes:
I am editing an audio and video clip for a friend. I removed two sections of the clip
and then pieced the 3 remaining clips together, including the Command T
transition. I rendered them and after saving the project, I set out to export it to
Quicktime movie, as you suggested. However, the results provided me with only
the third part of the three clip sequence. Is there anything obvious to you that I
might be doing wrong? I just want to export the file to my 2nd hard drive and then
run it through Apple Quicktime Export for Web. Please help.
Larry replies: Thanks for writing. The solution is easy. You forgot to remove the In and Out from
the Timeline before exporting. FCP exports the entire sequence, UNLESS you have an In or an
Out set, in which case it only exports from the In to the Out.
[ Go to Top. ]

WRAP-UP
Well, that's about it for this month.
For current news and in-depth interviews on what's happening in our industry, be sure to listen to
the Digital Production BuZZ every week.
●
●

Please check out my latest video tutorials.
Visit our store and buy something nice - FREE shipping thru the end of January!.

In the meantime, please continue sending me your comments and questions. I love hearing from
you and enjoy the conversations that develop around these stories.
Until next month, take care, and edit well.

Larry
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